
ATI DeskTop Help

Welcome to the ATI DeskTop, your single point access to all your ATI products and features.    
To learn more about the desktop, click on the area you want information on, or see: 
Introduction.

Note: Depending on the ATI products you've installed, your DeskTop may not have the same
icons as shown above.



Title Bar
This bar displays the name of your application and allows you to control the appearance of 
the application window.    For more information see Title Bar 



Menu Bar

The bar displays the various commands available.    For more information see Menu Bar



Desktop Buttons

These buttons provide quick access to ATI DeskTop functions.    For more information see 
DeskTop Buttons



Product Groups

This area displays the ATI products and features available to you.    Double-clicking on any of 
these icons will activate the application.    For more information see Product Groups



Status Bar

This bar displays brief explanations of the commands and icons you access.    For more 
information see Status Bar .



Introduction

If you've just installed an ATI product, take a few moments to familiarize yourself with the 
ATI DeskTop by browsing through this help file.    For help on individual products and 
features, use the Help On button.    If you wish to return to a major section of the help file, 
click on the icon in the title.

The ATI DeskTop lets you control and configure ATI products, features and drivers (upgraded 
for the Windows environment).    The DeskTop is supplied with all ATI products that run under
Windows 3.1. 

The DeskTop displays each installed ATI product in its own Product Group.    Within each 
product group, there's a Product Logo, plus a Feature Icon for each of the product's features. 
To access a feature or product, double-click on its icon.    If you want to get information on 
the product/feature before accessing it, click on the Help On button.

For Help on using Help, Press F1

See also:

Menu Bar
DeskTop Buttons
Status Bar 



Menu Bar

The two menus in the Menu Bar offer commands that let you control how the desktop 
operates:

The File menu:

Command Function
Exit exits the desktop.    You    can 

also exit by clicking the OK 
Button, Esc or Alt+F4.

The Help menu:

Command Function
Contents displays the ATI DeskTop help 

contents.
Using Help displays help on using this help

system.
Customer Support displays the ATI Customer 

Support dialog.
About displays version information on 

the ATI DeskTop.



DeskTop Buttons

The ATI DeskTop buttons provide quick access to desktop functions.    Most functions can also
be accessed through the commands in the menu bar.    For more information, click on the 
button you want to learn about: 



OK Button
Exits the desktop and restarts Windows.    See OK Button for more information.



Help On Button
Accesses help on the buttons and features in the desktop.    See Help On Button for more 
information.



Read Me Button
Accesses any Read Me files for products or features.    See Read Me Button for more 
information.



Main Logo
Accesses Customer Support and problem report information.    See Main Logo    for more 
information.



Main Logo

Double click this logo to access the Customer Support dialog  which allows you obtain 
customer support telephone numbers and generate a problem report. The report will include
pertinent data on your system and card configuration to help solve your problem. You should
have it ready before contacting Customer Support.

You can also shift-double-clicked the logo to obtain version information for the ATI DeskTop.



OK Button

Use the OK button to exit the ATI DeskTop.    You can also exit the desktop using the File 
menu Exit command, hitting Esc or Alt+F4.

The following dialog will appear whenever changes you've made require a restart of 
Windows:

If you select the Restart Windows button, Windows will automatically restart.    The screen 
will blank out for several seconds during this process.

If there are open applications with unsaved changes, it will prompt you to save your 
changes.    If you cancel any of these prompts, the restart will be aborted.    To restart 
Windows again, you will have to re-enter ATI DeskTop and choose OK.

If you select the Continue button, ATI DeskTop will close without restarting Windows, any 
changes you made will not be in effect until the next time you restart Windows.    Since INI 
files may have already been modified, you should exit Windows after selecting Continue.

If you select the Cancel Warning button, ATI DeskTop will not prompt you to restart 
Windows until the next time you make changes that require a restart.    Since the Restart 
Windows dialog is a handy reminder that you have made some unimplemented changes, it 
is not recommended that you choose this option.



Help On Button

When you select the Help On button, the cursor turns into the 'Help cursor and the 
application switches to Help Mode.    In this mode, clicking on any part of the ATI DeskTop will
access a help window for the selected item.    

In the case of product logos and feature icons, the help system for the specific product or 
feature will be accessed.    If there is no help available for the product or feature, general 
help on product logos or feature icons is displayed.
    
You can also:

· Toggled Help Mode on and off by pressing F2.

· Use Esc to return to normal mode.

· You can also obtain help on a selected feature by pressing F1.



Read Me Button

When you select the    Read Me button, the cursor turns into the 'Read Me' cursor and the 
application switches to Read Me Mode.    In this mode, clicking on any product logo or feature
icon will access any Read Me information available for the selected item.    Read Me 
information usually accompanies products to act as a convenient on-line reference of up-to-
date information.
    
You can also:

· Toggled Read Me mode on and off , by pressing F3.

· Use Esc to return to normal mode.



Status Bar

The Status Bar, located at the bottom of the ATI DeskTop window, displays a brief description
of the currently selected feature in the Product Group area.

In Help mode and Read Me mode, the status bar displays a short help message on these 
modes.



Product Groups

Each ATI product installed on your system will have its own product group on the DeskTop.    
Each group is identified by a product logo and contains a set of Feature Icons for each 
application feature or product .    For example:

Use the help cursorto get help on specific products.



Product Logos

A product logo uniquely identifies an ATI product installed on your system.    It performs the 
following functions:

· when selected with the help cusor , it accesses product specific help

· when selected with the read me cursor , it accesses product-level ReadMe 
information

· when double-clicked, it activates a product demo

· when shift-double-clicked, it accesses product version information .

Note: Not all Product Logos will perform these functions.



Feature Icons

Feature icons uniquely identify each feature application within a product (for example, a 
color adjustment feature application for a graphic accelerator product).    They also serve a 
variety of functions:

· when selected with the help cusor, they access feature-specific help

· when selected with the read me cursor, they access feature-specific Read Me 
information.

· when shift-double-clicked, they access feature version information.

To launch a feature application, double-click on its icon, or select it and hit Enter.

When a feature is selected, its name is highlighted and a short description appears in the 
status bar.



ATI Customer Support

The ATI Customer Support dialog can be accessed using the Customer Support option in the 
Help menu, or by double-clicking the ATI Main Logo.

Scroll through the dialog display to find information on getting assistance from ATI.    This 
information includes the following:

ATI Customer Support:
Hours: Monday to Friday 9:00am - 7:00pm EST
Telephone: (905) 882-2626
Facsimile: (905) 882-0546

ATI Download BBS: (905) 764-9404
24 hours (14400/9600/2400/1200 baud; 8 data, no parity, 1 stop)

CompuServe: GO ATITECH
ATI SUPPORT 74740,667

The dialog also allows you to create a problem report, which should be used when 
contacting ATI directly, or mailed to ATI Customer Support for further analysis. 

 To create a problem report:

1. In the ATI Customer Support dialog, select the Yes button.

The Problem Report window will appear.

2. In the window, complete all customer and problem information.

3. Select OK.

A problem report file will be automatically created and placed in your Windows 
directory (usually C:\WINDOWS), under the name ATI_PR.TXT.    

The Problem Report dialog will then appear, allowing you to access the Notepad 
application to view the report.

4. In the dialog, select Yes.

The Notepad application will open displaying your problem report.    From here you 
can use the Notepad commands to file or print the report.



Version Information
Version information identifies the version of the application you're running and copyright 
informtion.    This information can be accessed for any product or feature by double-clicking 
the product logo or feature icon, while holding down the Shift key.

Version information for the ATI DeskTop itself can be obtained by shift-double-clicking the ATI
Main Logo , or using the About command in the Help menu.



Title Bar

The title bar, located along the top of a window, displays the name of the application and 
filename and path of the current file.

You can use the title bar to move the window. Click the bar and drag the window to new 
location.    You can also move dialog boxes by dragging their title bars.

The title bar contains the following elements:

System Control Menu button

Minimize button

Name of the application

Filename and path of the current file.



System Control Menu Button

See also: System Control Menu.



Minimize Button



Maximize Button



System Control Menu

This menu, located on the title bar, controls the look of your application window.    It offers 
the following options:

Size 
Move 
Minimize 
Maximize 
Close
Switch To



Size Command

Use this command to display a four-headed arrow  you can use to size the active 
window.

 To change the window's size:

1. Press one of the DIRECTION keys (left, right, up, or down arrow keys from the keyboard) 
to move the pointer to the border you want to move.    

2. Press a DIRECTION key to move the border.

3. Press ENTER when the window is the size you want.

Note:    This command is unavailable if you maximize the window.

Shortcut
Mouse:Drag the size bars at the corners or edges of the window.



See Also



Move Command

Use this command to display a four-headed arrow  you can use to move the active 
window move or dialog box with the arrow keys.

 To move the window:

1. Press one of the DIRECTION keys (left, right, up, or down arrow keys from the keyboard) 
to move the outline of the window to a desired location.    

2. Press ENTER when the window is the where you want it.



Minimize Command

Use this command to reduce the MEDIACAPTURE window to an icon.

Shortcut

Mouse:Click the minimize icon  on the title bar.



Maximize Command

Use this command to enlarge the active window to fill the available space.

Shortcut

Mouse:Click the maximize icon  on the title bar; or double-click on the title bar.



Next Window Command

Use this command to switch to the next open document window.    MEDIACAPTURE 
determines which window is next according to the order in which you opened the windows.

Shortcut
Keys:    Ctrl+F6



See Also



Previous Window Command

Use this command to switch to the previous open document window.    MEDIACAPTURE 
determines which window is previous according to the order in which you opened the 
windows.

Shortcut
Keys:    Shift+Crtl+F6



Close Command

Use this command to close the active window or dialog box. 

Shortcuts
Keys: CTRL+F4 closes a document window, ALT+F4 closes the application window or

dialog box
Mouse: Double-clicking a Control-menu box is the same as choosing the Close 

command.



See Also



Restore Command

Use this command to return the active window to its size and position before you chose the 
Maximize or Minimize commands.



See Also



Switch To Command

Use this command to display a "Task List" of all open applications.    Use the list to switch to 
or close an application on the list.

Shortcut
Keys: CTRL+ESC



Task List dialog box

When you choose the Switch To command, this a dialog box will appear.    It offers the 
following options:

Task List
Select the application you want to switch to or close.
Switch To
Activates the selected application.
End Task
Closes the selected application.
Cancel
Closes the Task List box.
Cascade
Arranges open applications so they overlap and you can see each title bar.    This option does
not affect applications reduced to icons.
Tile
Arranges open applications into windows that do not overlap.    This option does not affect 
applications reduced to icons.
Arrange Icons
Arranges the icons of all minimized applications across the bottom of the screen.









Initial Setings Files
The INI file is used to configure the settings of an application when it is first run.




